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[bookmark: _Toc1370826789]Prerequisites
Below is a list of test script prerequisites that must be met for it to be run. 
1. The system has been updated in accordance with the Solution Deployment Procedure provided by Kinsmen Group. 
2. The tester has access to the target eDRAWS vault(s) with sufficient rights to perform the test steps. 
3. The tester has the Meridian Client installed in accordance with the Client Installation Procedure provided by Kinsmen Group. 
4. The tester has the latest version of the KINECT Drawing Integration package installed. Please see the release notes for the exact version number.
[bookmark: _Toc527643601][bookmark: _Toc126829883][bookmark: _Toc686723089]Reference and Associated Documents
Other documents that may accompany or be referenced by this document are as follows:
· Solution Deployment Procedure 
· Deployment Guide for the latest solution
· Client Installation Procedure
· Client Installation and setup instructions can be found here. 

[bookmark: _Toc980546595]Testing Outcomes
This test guide is split into key sections to allow quick and efficient testing of specific functionality. The following sections are available:
· Meridian Access: Validates client workstation is setup and key functionality is available and operating as expected.
· General Vault: Validates standard out-the-box functionality is operating correctly. i.e., Document Creation, Deletion, Viewing.
· Drawing Workflow & KINECT Integration: Validates drawing workflows and KINECT integration are operating as expected.
· Placeholder: Validates placeholder functionality, including creation of new placeholder, progression through the workflow and content replacement. 
· Searching: Validates searching functionality, including content, metadata, and other search methods are operating as expected.
· Civil 3D Models: Validates Civil 3D Model functionality, including creation, KINECT integration, and pdf workflow.
· Library: Validates functionality within the library area, including creation of library documents and data shortcuts and automatic creation of shared workspace. 


[bookmark: _Toc1192527118]Meridian Access
Tests in this section are relevant to access and client setup; they will ensure Power is accessible and Site Cache upload is operating as expected.
	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-ACC-01
	Update Site Cache URL
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Right click the application integration icon and select Local Workspace > Options. 
2. On the Site Cache tab, ensure that the Site Cache URL is set to the correct Enterprise Server address, update if necessary. 
3. Close the options dialog and open the Site Cache Log by right clicking the application integration icon and select Site Cache Log. 
4. Verify that the connection to the site cache server is connected successfully and no errors are present.
	Notes:


	UC-ACC-02
	Update KINECT UserSettings.xml
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Open and edit the UserSettings.xml file (Note: Usually located C:\Autodesk\KINECT). 
2. Ensure that <Server> and <vault> have the correct values assigned. 
	Notes:


	UC-ACC-03
	Ensure Access Via Power Web
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Open your preferred web browser and navigate to Meridian Power Web.
2. Ensure that the vault is accessible and that no warning messages appear on the screen.

	Notes:


	UC-ACC-04
	Ensure Access Via Power User
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Open the Meridian Power User client.
2. Ensure that the vault is accessible and that no warning messages appear on the screen. 

	Notes:


	UC-ACC-05
	Verify Site Cache Functionality
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Return to Meridian Power Web and locate a single drawing in the Meridian Vault and download it using the "Download Document" command. 
2. Verify that no errors are returned from Site Cache and that the document is downloaded successfully to your local workspace.
	Notes:




[bookmark: _Toc1723570730]General Vault
This section is relevant to general vault functionality and will ensure that outside the box general functionality is operating as required. 
	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-EDR-01
	Create New Project (Work in Progress)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. At the Project type level of the Work in Progress structure. Right click Design and select New > Folders & Projects > Design Project. 
2. Select a project from the Name dropdown and verify the project list. (Note: The project list is filtered down to only projects for your specific vault.) 
3. Click Finish to create the project. 
	Notes:
A project has not been created by Kinsmen Group due to the testing occurring on a live environment. All other tests are conducted within PROJECT X by agreement with USBR.

	UC-EDR-02
	Verify Folder(s) cannot be Renamed (Negative)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select a previously created project and from the toolbar menu, navigate to the Edit tab and select Rename. Append “-Test” to the folder name and click Yes. 
2. An error will be shown on screen stating that the folder cannot be renamed.
	Notes:


	UC-EDR-03
	Create a new drawing from the Project folder level
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to a previously created project folder and select it. From the toolbar menu, navigate to the new tab and select New Document. 
2. Select Drawing from the document type dropdown and click Next. 
3. [bookmark: _Int_vWsIA0gd]Select AutoCAD_Electrical from the document template dropdown and click Next. (Note: Verify that only the four correct templates are visible and no Document_Template_X instances exist.)
4. Complete any mandatory fields on the Title Block wizard page and click Finish. (Note: Project should be pre-populated based on the project selected at the start.)
5. Ensure the newly created drawing is filed as expected. 
	Notes:


	UC-EDR-04
	Create a new drawing from the Root folder
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to the Root vault folder and select it. From the toolbar menu, navigate to the new tab and select New Document. 
2. Select Drawing from the document type dropdown and click Next. 
3. Select AutoCAD_Electrical from the document template dropdown and click Next. (Note: Verify that only the four correct templates are visible and no Document_Template_X instances exist.)
4. Complete any mandatory fields on the Title Block wizard page and click Finish. (Note: Project dropdown will be filtered and only show projects available for your selected vault.)
5. Ensure the newly created drawing is filed as expected. 
	Notes:


	UC-EDR-05
	Import a new Drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to a previously created project folder and select it. From the toolbar menu, navigate to the new tab and select Import Documents. 
2. Drag and drop a sample drawing (under 5mb) onto the Import documents wizard page and click Next. (Note: Alternatively, you can select the Add button and manually navigate to the sample drawing.) 
3. Select Drawing from the document type dropdown and click Next. 
4. Complete any mandatory fields on the Title Block wizard page and click Finish. (Note: Project should be pre-populated based on the project selected at the start.)
5. Ensure the newly created drawing is filed as expected. 
	Notes:

	UC-EDR-06
	Perform Replace Document Content action on a drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to the drawing created in a previous step and select it. (Note: This drawing should be in the draft status and not locked to your local workspace) From the toolbar menu, navigate to Edit and select Replace Content. 
2. Click Choose File and manually navigate to a sample drawing and double click it. 
3. Click yes to replace the content of the selected drawing.
	Notes:


	UC-EDR-07
	Replace Content on a drawing with uppercase extension
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to the drawing created in a previous step and select it. (Note: This drawing should be in the draft status but not locked to your local workspace and have a lower-case extension)
2. From the toolbar menu, navigate to Edit and select Replace Content. 
3. Select Choose file and manually navigate to a sample drawing and double click it. (Note: the sample drawing should have an upper-case extension .DWG for example.)
4. Click yes to replace the content of the selected drawing.
	Notes:


	UC-EDR-08
	View the native and rendition of a newly created drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Re-open Power Web in the Microsoft Edge browser. (Note: Ensure that Power Web is launched in Internet Explorer Mode and Active X is enabled in your Power Web Preferences)
2. Navigate to a newly created drawing anywhere in the vault and select it. (Note: ensure the drawing selected has content and a rendition created. Create a rendition if required.)
3. Select the native viewer icon (Note: Glasses) to view the Native content. 
4. Select the rendition viewer icon (Note: Glasses with Red mark) to view the pdf rendition.
	Notes:


	UC-EDR-09
	Create Rendition (Server Side)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In Microsoft Edge browser, exit Internet Explorer Mode and return to Power Web.
2. Select an existing drawing and send to the rendition server using the Update Rendition command located in the document toolbar menu. 
3. Verify that no errors are returned, and that the rendition is created/updated.

	Notes:


	UC-EDR-10
	Edit drawing properties on a newly created drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to a newly created drawing and select it. 
2. On the properties pane navigate to the Title block page and select the Edit button. 
3. Update any relevant fields and click Ok to apply changes. 
4. Ensure that the property updates have been applied and not reverted. 
	Notes:


	UC-EDR-11
	Edit drawing properties on a previously created drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to a previously created drawing and select it. 
2. On the properties pane navigate to the Title block page and select the Edit button. 
3. Update any relevant fields and click Ok to apply changes. Ensure that the property updates have been applied and not reverted.
	Notes:


	UC-EDR-12
	Compare 2 revisions using the comparison tool
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select a drawing containing more than one revision. 
2. Navigate to the Revion tab and select the checkbox two different revisions to compare.
3. From the revision toolbar menu select compare renditions option.
4. Verify the comparison tool works as expected any any differences are shown. 
5. Exit the comparison tool. 


	Notes:


	UC-EDR-13
	Mark for Deletion
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Navigate to any drawing and select it. 
2. Right click it and navigate to Commands > Document Control and select Mark for Deletion. 
3. Add a Deletion Comment and click Finish.
4. The document log will indicate who marked the document for deletion and the comment given.
	Notes:


	UC-EDR-14
	Unmark for deletion
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Navigate to the previously marked for deletion drawing and select it.
2. Right click it and navigate to Commands > Document Control and select Unmark for Deletion. 
3. Verify the deletion comment has the correct format (<Username> – <Comment>) and click Finish.
	Notes:


	UC-EDR-15
	Approve Deletion
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Navigate to any drawing marked for deletion and select it. 
2. Right click it and navigate to Commands > Document Control and select Approve Deletion. (Note: you may need to mark another document for deletion to complete this step)
	Notes:






[bookmark: _Toc1579722436]Drawing Workflow & KINECT Integration
This section will set out the test scripts for ensuring that all drawing workflows and KINECT Integration work as expected. 
	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-WFL-01
	Send an existing drawing to a Drafter
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to a previously created drawing with a status of Unchanged in the vault and select it. If no such documents are available, then one should be revised from Official Records.
2. From the toolbar menu, navigate to Workflow and select Send to Drafter. 
3. Select a To-Do Person and click Ok. 
4. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
5. Select a Revision Station from the dropdown and click Finish. 
6. Ensure the drawing has a status of Draft and the To-Do Person is set to you.
	Notes:


	UC-WFL-02
	Edit drawing in application (Part 1)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Work in Progress scope, navigate to a previously created drawing and select it. (Note: This drawing should be in a project and have a status of Draft, with a Revision of 0.1) 
2. In the properties pane navigate to the Title Block page and select the Assign Permanent Number button to assign a new permanent number. (6XXXX) (Note: This number will vary depending on what the current highest sequence number is across all eDRAWS vaults in the same Region)
3. From the toolbar menu, navigate to Edit and select Open. (Note: that the open option can sometimes be hidden in a dropdown next to Download Document)
	Notes:


	UC-WFL-03
	Edit drawing in application – Edit User Assignments (Part 2)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Once the previously opened drawing appears in AutoCAD, verify that the Kinsmen ribbon tab is available, and the following buttons are enabled: "Edit User Assignments", "Update Rendition". 
2. Select the "Edit User Assignments" button and ensure all the fields are populated. Click Apply to update the title block and then click close to exit the dialog. 
3. Verify that the changes are visible in the title block.

	Notes:


	UC-WFL-04
	Edit drawing in application – Update Rendition (Part 3)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Edit the drawing content (Note: Any visible update will be sufficient) and click the save button. 
2. Navigate to the Kinsmen ribbon tab and select Update Rendition. Save and close the Drawing in AutoCAD. 
3. In Meridian Power Web verify the changes made have been saved and are visible.
	Notes:


	UC-WFL-05
	Verify drawing rendition print stamp
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Navigate to the previously used drawing and select it. 
2. Select the rendition viewer icon (Note: Glasses with Red mark) to view the pdf rendition.
3. Verify that the Draft print stamp is visible in the top left corner. 
	Notes:


	UC-WFL-06
	Send for Technical Approval
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction: 
1. Select the previously edited drawing. From the toolbar menu, navigate to Workflow and select Send for Technical Approval. 
2. Select a To-Do Person and click Ok. (Note: only users in the BC_TECHAPPROVERS group will be shown)
3. If prompted to confirm the computer to exchange the documents with, ensure your current machine is selected from the dropdown and click yes. 
4. Drawing is progressed through the workflow and has a status of Technical Approval, and the revision updated. (Note: Print Stamp will also be updated to show Technical Approval)
5. The chosen approver will receive an email indicating that they have a document approval to action.
	Notes:


	UC-WFL-07
	Reject Technical Approval  
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the previously edited drawing. From the toolbar menu, navigate to Workflow and select Reject. 
2. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes.  
3. Drawing is progressed through the workflow but skips the Rejected state and instead has the status of Draft. (Note: Print Stamp will also be updated) The Document log will indicate that the approval was rejected and then it was automatically reassigned to the Draft state.
	Notes:


	UC-WFL-08
	Resend for Technical Approval & Approve
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Reselect the rejected drawing (Note: Drawing should now be in draft state) and repeat steps in UC-WFL-06.
2. Select the previously edited drawing which should now be in the Technical Approval state. 
3. From the toolbar menu, navigate to Workflow and select Tech Approval. 
4. Select a To-Do Person and click Ok. (Note: only users in the BC_ADMINAPPROVERS group will be shown excluding yourself)
5. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
6. Leave the Reason at the default, enter the Approver Title and select the Professional Registration from the drop down list. (Note: the Reason can be changed if required by selecting another option from the dropdown)
7. When prompted to complete the electronic signature, select your PIV card from the username dropdown and enter the PIN. Click Ok.
8. Drawing is progressed through the workflow and has a status of Admin Approval. (Note: Print Stamp will also be updated to show Admin Approval)
9. The chosen approver will receive an email indicating that they have a document approval to action.
	Notes:


	UC-WFL-09
	Reject Admin Approval
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the previously edited drawing. (Note: the To Do person is not yourself as by default you are not allowed to send to yourself for Admin Approval in the previous step) 
2. You will first have to use the Reassign To-Do Persons command to reassign the drawing to you.  
3. From the toolbar menu, navigate to Workflow and select Reject. If required enter a comment and click Ok. 
4. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
5. Drawing is progressed through the workflow but skips the Rejected state and instead has the status of Draft. (Note: Print Stamp will also be updated) The Document log will indicate that the approval was rejected and then it was automatically reassigned to the Draft state.
	Notes:


	UC-WFL-10
	Send for Admin Approval  
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the previously edited drawing and repeat test UC-WFL-08 get the document back to Admin Approval state. (Note: the To Do person is not yourself as by default you are not allowed to send to yourself for Admin Approval in the previous step)
2. You will first have to use the Reassign To-Do Persons command to reassign the drawing to you.  
3. From the toolbar menu, navigate to Workflow and select Admin Approval. 
4. Enter a comment if required and click Ok. 
5. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
6. Leave the Reason at the default, enter the Approver Title and select the Professional Registration from the drop down list. (Note: the Reason can be changed if required by selecting another option from the dropdown)
7. When prompted to complete the electronic signature, select your PIV card from the username dropdown and enter the PIN. Click Ok.
8. Drawing is progressed through the workflow and has a status of Ready for Release. (Note: Print Stamp will also be updated to show Ready for Release)
	Notes:


	UC-WFL-11
	Perform Release to Official Records
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select a drawing with the status of Ready for Release. Right click it and select Project > Assign > Release from Folder. 
2. The Drawing will be released in the Official Records Area.

	Notes:


	UC-WFL-12
	Create a new project copy of a released drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Change your scope from 2-Work-In-Progress to 1-Official Records
2. Using any drawing in the Official Records area, create a revision using the Assign to Folder command from the Project toolbar menu.
3. Change your scope from 1-Official Records to 2-Work-In-Progress.
4. Once the drawing is in a project and in the Unchanged state, navigate to the Workflow toolbar menu and select Send to Drafter. 
5. Select a To-Do Person and click Ok. 
6. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
7. Verify that the revision station dropdown list in the wizard page has more than one value listed, select a value, and click Finish.
8. Ensure the drawing has a status of Draft and the To-Do Person is set to you.
	Notes:


	UC-WFL-13
	Retire Drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In either the Work-In-Progress or Models scope, select a single drawing which is at the Ready for Release state. 
2. Navigate to the Workflow toolbar menu and select Retire.
3. Enter a comment if required and click Ok. 
4. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes.
5. Verify that the document is moved to the Storage area and has a status of Retired.
	Notes:


	UC-WFL-14
	Unretire Drawing
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the single drawing retired in the previous step. 
2. Navigate to the Workflow toolbar menu and select Unretire.
3. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes.
4. Verify that the document is moved back to the WIP (Work in Progress) or Models area (whichever scope it originated from) and has a status of Released.
	Notes:





[bookmark: _Toc1600489447]Placeholder
	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-PLH-01
	Create Placeholder
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Ensure that the Work in Progress Scope is selected. 
2. Create a new Drawing document using the Placeholder (PDF) template. 
3. Choose a temporary Number. 
4. Verify that the document is created with the Placeholder Template, the Rendition is present and the block information has been updated with the correct Document Number, Revision and status.
	Notes:


	UC-PLH-02
	Create Multiple Placeholders
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Create 2 additional copies of the drawing created in the step above using the Copy Multiple command. Metadata may be changed for each copy if desired. 
2. Verify that the additional documents have been created with the Placeholder Template, the Rendition is present and the block information has been updated with the correct Document Number, Revision and status.
	Notes:


	UC-PLH-03
	Route Placeholder for Technical Approval (Negative)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Execute the Send for Technical Approval workflow transition on one of the newly created documents. 
2. Verify that the command is blocked for the Placeholder document. 
	Notes:


	UC-PLH-04
	Assign Permanent Number
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select a previously created placeholder.
2. From the Title Block page Assign a permanent number by using the related button.
3. Confirm the Number has been updated aswell as the associated rendition. 
	Notes:


	UC-PLH-05
	Create Replacement Content
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Create a PDF from a valid DWG file: 
a. Create a new AutoCAD DWG using the BOR template
b. Set the Designed By, Drawn By & Checked By values for the document
c. Ensure the correct Drawing Number is set and the Draft Stamp is hidden
d. Plot to PDF
	Notes:


	UC-PLH-06
	Replace Content
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Replace the content of one of the Placeholder documents using the PDF file generated above. 
2. Verify that the Placeholder document is updated with the new document content.
	Notes:


	UC-PLH-07
	Route Placeholder for Tech Approval
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the previously updated placeholder. From the toolbar menu, navigate to Workflow and select Send for Technical Approval. 
2. Select a To-Do Person and click Ok. (Note: only users in the BC_TECHAPPROVERS group will be shown)
3. If prompted to confirm the computer to exchange the documents with, ensure your current machine is selected from the dropdown and click yes. 
4. Drawing is progressed through the workflow and has a status of Technical Approval, and the revision updated. (Note: Print Stamp will also be updated to show Technical Approval)
5. The chosen approver will receive an email indicating that they have a document approval to action.
	Notes:


	UC-PLH-08
	Tech Approve Placeholder Document
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the previously updated Placeholder 
2. From the toolbar menu, navigate to Workflow and select Tech Approval. 
3. Select a To-Do Person and click Ok. (Note: only users in the BC_ADMINAPPROVERS group will be shown excluding yourself)
4. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
5. Leave the Reason at the default, enter the Approver Title and select the Professional Registration from the drop down list. (Note: the Reason can be changed if required by selecting another option from the dropdown)
6. When prompted to complete the electronic signature, select your PIV card from the username dropdown and enter the PIN. Click Ok.
7. Drawing is progressed through the workflow and has a status of Admin Approval. (Note: Print Stamp will also be updated to show Admin Approval)
8. The chosen approver will receive an email indicating that they have a document approval to action.
	Notes:


	UC-PLH-09
	Admin Approve Placeholder Document
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select the previously edited placeholder 
2. You will first have to use the Reassign To-Do Persons command to reassign the drawing to you.  
3. From the toolbar menu, navigate to Workflow and select Admin Approval. 
4. Enter a comment if required and click Ok. 
5. If prompted to confirm what computer the documents will be exchanged with, ensure your current machine is selected from the dropdown and click Yes. 
6. Leave the Reason at the default, enter the Approver Title and select the Professional Registration from the drop down list. (Note: the Reason can be changed if required by selecting another option from the dropdown)
7. When prompted to complete the electronic signature, select your PIV card from the username dropdown and enter the PIN. Click Ok.
8. Placeholder is progressed through the workflow and has a status of Ready for Release. (Note: Print Stamp will also be updated to show Ready for Release)

	Notes:


	UC-PLH-10
	Release Placeholder Document
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Select a placeholder with the status of Ready for Release. Right click it and select Project > Assign > Release from Folder. 
2. The Drawing will be released in the Official Records Area.

	





[bookmark: _Toc1724713581]Searching
This section describes all tests required to validate searching functionality within the eDRAWS vault. 
	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-SRH-01
	Perform a Quick Search
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Perform a search for a drawing that exists in Meridian using Quick Search.

	Notes:


	UC-SRH-02
	Perform a search – by Meta-Data
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Perform a search for a drawing and meta-data that exists in Meridian using the Any Text Property search criteria.
	Notes:


	UC-SRH-03
	Perform a search – by Content
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Perform a search for a drawing that exists in Meridian using the Document Content search criteria with values that exist in the drawing content.

	Notes:


	UC-SRH-04
	Perform a search – within a specific folder
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Perform a search for a drawing that exists in Meridian within a specific folder using search functionality and setting criteria to search within a specific folder.
	Notes:


	UC-SRH-05
	Perform a search – Search for a folder
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Perform a search for a folder that exists in Meridian using the Find Folders search.

	Notes:



[bookmark: _Toc1480554178]Civil 3D Models 
	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-C3D-01
	Create a Project (Models)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Ensure the Models Scope is selected.
2. Create a new Shared Project Folder under the top-level Civil 3D folder. 
3. Once the project is created, edit the properties and verify that the workspace location is set to the correct UNC path. 
4. Ensure that the path entered is unique and not used for any other projects.
5. Ensure that the Synchronize Automatically checkbox is ticked and set the Default Document Type dropdown to 3D Model.

	Notes:
A project has not been created by Kinsmen Group due to the testing occurring on a live environment. All other tests are conducted within PROJECT X by agreement with USBR.

	UC-C3D-02
	Create a new Civil 3D Model 
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Create a new 3D Model under the previously created project.
2. Ensure that only AutoCAD, Civil 3D, and AutoCAD_Electrical templates are available.
3. Choose the Civil 3D template. 
4. Enter appropriate property values, checking that all dropdown lists are populated, and complete the wizard. 
5. Verify that the drawing is created in the correct location.
	Notes:


	UC-C3D-03
	Import Civil 3D Model
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Import a single (1) model (file size < 5 Mb) into a model project folder. 
2. Ensure the model file is imported correctly, and all specified property values have been applied.
	Notes:


	UC-C3D-04
	Edit drawing properties on a newly created Model
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Models scope, navigate to a newly created drawing and select it. 
2. On the properties pane navigate to the Model page and select the Edit button. 
3. Verify that the drawing number field is not editable unless you are an SDM level user or above.
4. Update any relevant fields and click Ok to apply changes. 
5. Ensure that the property updates have been applied and not reverted. 
	Notes:


	UC-C3D-05
	Edit drawing properties on a previously created Model
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. In the Models scope, navigate to a previously created drawing and select it. 
2. On the properties pane navigate to the Model page and select the Edit button. 
3. Verify that the drawing number field is not editable unless you are an SDM level user or above.
4. Update any relevant fields and click Ok to apply changes. 
5. Ensure that the property updates have been applied and not reverted.
	Notes:


	UC-C3D-06
	Open Civil 3D Model in Application
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Open the previously created model in the native application by double clicking it or selecting the Edit tab in the menu toolbar and then Open. 
2. Verify that the drawing opens in the correct version of AutoCAD and that the Meridian and Kinsmen ribbon tabs are available. 
3. Check that the title block contains the correct values (Drawing Number, Project, Feature).
	

	UC-C3D-07
	Create a New Layout
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Right click the 22x43 layout and select Move or Copy. 
2. Select Create a Copy checkbox and click Ok to create a copy of the existing single layout (22x34).
	Notes:


	UC-C3D-08
	Apply Temporary Number(s)
	<NAME>
	MM/DD/YY
	Pass/Fail

	 Test Instruction:
1. Use the Update Number(s) command on the Kinsmen tab, select the checkboxes next to the layouts and select Temporary Number to apply new temporary numbers to the two layouts. 
2. Verify that the layouts are renamed using the correct "-Txx- " numbering. 

	Notes:


	UC-C3D-09
	Edit User Assignments
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Use the Edit User Assignments command on the Kinsmen tab to update the User assignments for both layouts. 
2. Ensure that a user is selected for the "Designed By", "Drawn By" and "Checked By" columns, also verify that any other mandatory value (Note: denoted by a red exclamation mark) is populated. 
3. Click Apply followed by Close and verify that the title block for each layout is updated with the new values.
	Notes:


	UC-C3D-10
	Publish Layouts with Temporary numbers
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Use the Publish Layout(s) command on the Kinsmen tab to publish PDF sheets of the two layouts to Meridian. 
2. Verify that no errors are shown in the Publish Layout dialog and that both sheets are created in the vault with matching properties and are linked to the parent Model. 
3. Verify that the published sheets have renditions, have a visible stamp in the top left-hand corner indicating the workflow state and display the BOR Draft Watermark.
4. Verify that Placeholder text has been added to the published sheets in light gray covering the Tech Approver, Admin Approver, Admin Approver Title, and Drawing Date fields.
	Notes:


	UC-C3D-11
	Route Layout for Tech Approval (Negative)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Switch to Meridian PowerWeb and change the scope to 2-Work-In-Progress.
2. Select one of the previously published PDF layouts and execute the Send for Technical Approval workflow transition. 
3. Verify that the operation is blocked because the layout does not have a permanent number.
(Note: If an error is shown stating that the pdf is missing, use the Unlock Document command in Meridian to fix this.)
	Notes:


	UC-C3D-12
	Assign Permanent Number
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Switch back to Civil 3D, use the Update Number(s) command on the Kinsmen tab, select the checkbox of one of the layouts and select Permanent Number to apply a permanent number to the one of the two layouts.
2. Verify that the layout is renamed using the correct (6xxxx series) numbering. 
3. Verify that the title block is updated with the new number and that the existing PDF layout in Meridian is renamed to match.


	Notes:


	UC-C3D-13
	Publish Layouts with Permanent Numbers
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Use the Publish Layout(s) command on the Kinsmen tab to republish the PDF record for the layout with the permanent number. 
2. Verify that no errors are shown in the Publish Layout dialog and that the sheet is updated in the vault. 
3. Verify that the published sheet has a rendition stamped with the "Draft" status and the BOR Draft Watermark.

(Note: This step is necessary as an existing published sheet may not be sent for approval until its metadata is republished. Renaming in the step above is not sufficient.)


	Notes:


	UC-C3D-14
	Route Layout for Tech Approval 
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Switch to Meridian PowerWeb, select the layout PDF with the permanent number and execute the Send for Technical Approval workflow transition. 
2. Verify that the operation is successful, and the document moves to the Technical Approval state, also check that the rendition is updated with the correct status stamp and that the BOR Draft Watermark is removed.
(Note: If an error is shown stating that the pdf is missing, use the "Unlock Document" command in Meridian to fix this.)


	Notes:


	UC-C3D-15
	Tech Approve Layout
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Using the layout PDF document from the previous step, use the Tech Approval workflow transition. 
2. Fill in the approval dialog and sign the transition electronically when prompted. 
3. Verify that the operation is successful, and the document moves to the Admin Approval state, also check that the rendition is updated with the correct status stamp and that no BOR Draft Watermark is displayed.
	Notes:


	UC-C3D-16
	Admin Approve Layout
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Using the layout PDF document from the previous step, use the Admin Approval workflow transition. 
2. If the To-do person is not the current user, first reassign the document so that the action can be completed. 
3. Fill in the approval dialog and sign the transition electronically when prompted. 
4. Verify that the operation is successful, and the document moves to the Ready for Release state, also check that the rendition is updated with the correct status stamp and that no BOR Draft Watermark is displayed.
	Notes:


	UC-C3D-17
	Release Layout
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Still in Meridian PowerWeb and with the model document active, execute the Release workflow transition. 
2. Verify that the operation is blocked because not all Model sheets are released.
	Notes:


	UC-C3D-18
	Route Model for Approval
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Switch back to Civil 3D, use the Save & Release command on the Meridian tab to update and close the model. 
2. Switch to Meridian PowerWeb, locate the model document and execute the Send for Approval workflow transition.
	Notes:


	UC-C3D-19
	Release Model
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Still in Meridian PowerWeb and with the model document active, execute the Release workflow transition. 
2. Verify that the operation is blocked because not all Model sheets are released.
	Notes:


	UC-C3D-20
	Release Model (Part 2)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Remove any references to unreleased Model sheets and attempt to release the Model again. 
2. Verify that the operation is successful.
	

	UC-C3D-21
	Create a Sub Project
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Using the previously released Model, execute the New Sub-Project command under Table Management to create a two new Sub Projects with any desired name.
	

	UC-C3D-22
	Delete a Sub Project
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Using the New-Sub Project command search and delete one of the previously created Sub Projects.
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	Test No
	Test Case
	Tested By
	Test Date
	Pass/Fail

	UC-LBR-01
	Create New Library Document
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. With the Models Scope active, create a new Library document. 
2. The Library Document should be created in the Library Share and previously created Sub-Project.
3. Verify that the Description field is visible and editable.
4. Verify that document types other than DWG may be created as Library documents.
	Notes:


	UC-LBR-02
	Create Data Shortcuts (Part 1)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Double-click the Library Document created in the previous step to open it in Civil 3D. 
2. Ensure the Working Folder level is set to the feature level of the library document path. 
3. Create a new Data Shortcuts Project Folder with a name that matches the sub project previously created.
	Notes:


	UC-LBR-03
	Create Data Shortcuts (Part 2)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Create a new Surface (Prospector tab, Surfaces, Create Surface, accept defaults). 
2. Create Data Shortcuts (Prospector tab, Data Shortcuts, Create Data Shortcuts). 
3. Select all surfaces and click Ok.
	Notes:


	UC-LBR-04
	Create Data Shortcuts (Part 3)
	<NAME>
	MM/DD/YY
	Pass/Fail

	Test Instruction:
1. Use the Update Vault command from the Project Management pane on the Meridian Ribbon.
2. Observe that new document wizards are shown for any additional data shortcuts.
3. Save the Drawing back to Meridian and close the file in Civil 3D.
4. Ensure XML files are synchronized, and Shortcuts have been created in the Sub Project folder.
	Notes:
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